QUADRATIC OPTIMIZATION WITH EXCEL SOLVER CODE

Jitendra Singh, Rajpal Singh, Ravikant Sharma
1Associate Professor, 2, 3Professor
1, 2, 3Department of Mathematics, Govt. Raj Rishi College Alwar (Raj.) India

Abstract: This paper presents a study on the use of Excel Solver techniques for solving quadratic optimization problems. Quadratic optimization is a mathematical optimization technique used to solve optimization problems that involve nonlinear objective functions and/or nonlinear constraints. Excel Solver is a widely-used tool for optimization problems, and it has made it easier for researchers and practitioners to apply quadratic optimization to a wide range of problems in various fields. We demonstrate the effectiveness of Excel Solver in finding optimal solutions to quadratic optimization problems and compare the results to other optimization techniques. Our findings indicate that Excel Solver can be an effective tool for solving quadratic optimization problems and has significant potential for use in a wide range of applications.

Index Terms - Quadratic optimization problem, Excel Solver, Optimal Solution, Optimization Techniques

I. INTRODUCTION

The Excel Solver was first introduced by Frontline Systems in 1990 as an add-in for Microsoft Excel 3.0. It was one of the first optimization tools for spreadsheets and was quickly adopted by many organizations for a wide range of applications, including finance, operations research, and engineering. Over the years, the Excel Solver has been updated and improved with new features and capabilities, including the ability to handle quadratic and integer-constrained problems, as well as the integration of evolutionary algorithms and other advanced optimization techniques. In 2016, Microsoft acquired Frontline Systems' intellectual property for the Excel Solver and began offering it as a built-in feature of Microsoft Excel. Since then, the Excel Solver has continued to evolve and is now widely used by businesses and individuals around the world.

Today, the Excel Solver remains one of the most popular optimization tools for spreadsheets, offering a powerful and flexible platform for solving a wide range of optimization problems. Quadratic optimization is a mathematical optimization technique used to solve optimization problems that involve quadratic objective functions and linear constraints. In contrast to linear programming, which involves linear functions, quadratic optimization can be more complex and challenging because it involves functions that are not linear. Quadratic optimization has numerous applications in fields such as engineering, finance, economics, operations research, and management science and helps to improve efficiency, reduce costs, and increase profits in business and industry. In addition, it can also help to optimize the performance of systems and processes, thereby increasing their effectiveness and reliability. Excel Solver is a widely-used tool for solving quadratic optimization problems, and it has made it easier for researchers and practitioners to apply quadratic optimization to a wide range of problems in various fields. As a result, there has been a significant increase in the use of Excel Solver for optimization problems in recent years.

Leon O. Chua, And Gui-Nian Lin (1984) explored a novel approach to nonlinear programming that doesn't rely on traditional numerical computation methods. Instead, it introduces a concept called "nonlinear
memristor,” a precursor to the now-famous memristor device. Enrique Del Castillo & Douglas C. Montgomery (1993) addressed the dual response problem in quality improvement and explores a nonlinear programming approach to simultaneously optimize multiple responses in experimental design. Daniel Fylstra et al (1998) introduced the concept of optimization problems and how they are prevalent in various fields such as engineering, finance, and logistics. They then delve into explaining the features and functionality of the Solver tool, which is an add-in for Microsoft Excel that assists in solving linear and nonlinear optimization problems. The article outlines the steps to install and activate Solver within Excel, making it approachable for users who may not be familiar with the tool. Jonathan P. Pinder (2013) focused on using the Excel Solver tool to introduce the concept of nonlinear regression in the context of decision sciences education. Duan, C. J, Hu, J. and Garrott, S.C. (2016) presented a case study involving the application of Excel Solver to solve a truck routing problem for Braydon Farms, illustrating the practical use of optimization techniques in logistics. Namrata Tripathi and Namita Srivastava (2017) explored and compare the utilization of two distinct optimization tools, MATLAB's Optimum Toolbox and Excel Solver, to solve optimization problems. Laura Briones and et al. (2020) focused on demonstrating the practical application of the Microsoft Excel Solver tool in solving optimization problems related to distillation sequences.  Samithamby senthlinathan (2021) focused on solving a linear programming problem using the Excel Solver tool and presents an optimal solution. These literature reviews provide a comprehensive overview of the use of Excel Solver for solving quadratic optimization problems and their applications in various fields. These references provide further insights into the use of Excel Solver for solving quadratic optimization problems, with a focus on various fields such as mathematics, engineering, and education.

II. MS Excel Solver:

MS Excel Solver is a widely used optimization tool that is included with basic installations of MS Excel. It was developed by Frontline Systems to solve optimization problems within an Excel workbook. The Solver enables users to determine an optimal value for a cell that serves as the objective function, subject to certain constraints or limitations, by adjusting the values of decision variable cells. The Solver model consists of the objective function cell, conditions, decision variable cells, and the formulas that link them together. The Solver employs a range of methods, including linear programming, quadratic optimization, genetic and evolutionary algorithms, to find solutions. To perform quadratic optimization, the MS Excel Solver tool uses the generalized reduced gradient (GRG) method as implemented in GRG2 code. For linear programming, simplex and dual simplex methods are utilized, while the branch-and-bound method is used for integer-constrained problems. Additionally, there is an evolutionary solving method that combines genetic algorithms and local search methods to solve non-smooth optimization, which has been developed by Frontline Systems. The Excel Solver has limitations on the number of variables and constraints that can be used in a model. The specific limits depend on the version of Excel and Solver being used. In Excel 2019, the Solver add-in can handle up to 200 decision variables and up to 100 constraints. In older versions of Excel, such as Excel 2016, the Solver add-in had lower limits, with only 200 total constraints and variables combined. Additionally, the limits can vary depending on the complexity of the problem and the computer resources available. When the number of variables and constraints exceeds the limits, the Solver may encounter performance issues or may not be able to find a solution at all.

III. Mathematical Formulation of the Problem

A quadratic optimization problem involves optimizing a quadratic objective function subject to linear equality and/or inequality constraints. The general formulation of a quadratic optimization problem can be expressed as follows:

Objective Function: Minimize or maximize a quadratic function of the decision variables, typically represented as:

\[ f(x) = \frac{1}{2} x^T Q x + c^T x \]

Constraints: Subject to linear equality and/or inequality constraints, which can be written as?
\[ Ax \leq b \quad \text{(Linear Equality / Inequality Constraints)} \]
Where $x$ is the vector of decision variables (column vector), $Q$ is a symmetric positive semi-definite matrix of quadratic coefficients, $c$ is a vector of linear coefficients, $A$ is the matrix of coefficients for the equality constraints, $b$ is the vector of constants for the equality constraints.

### IV. METHODOLOGY

Step 1: To install the Solver add-in in Microsoft Excel (One Time Process): Open Excel and Go to the "File" tab in the ribbon and Click on "Options" at the bottom left corner of the window and select "Add-Ins" from the left sidebar. In the "Add-Ins" section, choose "Excel Add-ins" from the Manage dropdown menu, and then click "Go...". In the Add-Ins dialog box, find and check the "Solver Add-in" checkbox and Click "OK" to close the dialog box. Now see the Solver button on the Data tab in the ribbon.

Step 2: Once the Solver add-in is installed, then the quadratic optimization problem is solve in Excel as:

Step 3: Open or create a worksheet that contains the quadratic optimization problem that want to solve and define objective function, decision variables, constraints, and any necessary parameters.

Step 4: Click on the "Solver" button (Windows) or go to the "Data" menu and select "Solver". In the Solver Parameters dialog box, set the objective function to maximize or minimize, and specify the cells for decision variables, set the cell of Limit constraints, and other options. Click the "Add" button to add constraints.

Step 5: Click "Options" and tick "Assume nonlinear Model" and "Assume Non-Negative Click the "Solve" button to run the solver. Solver will attempt to find the optimal values for your decision variables based on the specified constraints. Once Solver finds a solution, it will display the optimal values that optimized the objective function value.

### V. ILLUSTRATIVE EXAMPLE

Consider the following problem:

Max $f(x) = 2x_1 + x_2 - x_1^2$  
Subject to  
$2x_1 + 3x_2 \leq 6$,  
$2x_1 + x_2 \leq 4$,  
$x_1, x_2 \geq 0$  

Excel Code of the Quadratic Optimization Problem

Max $f(x) = 2*B11+C11-B11^2$  
Subject to  
SUM(B6*B$11+C6*C$11) <= 6  
SUM(B7*B$11+C7*C$11) <= 4

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Computational Solution for Quadratic Optimization Problem</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>INPUT RESULTS</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td></td>
<td>x1</td>
<td>x2</td>
<td>TOTAL</td>
<td>SIGN</td>
</tr>
<tr>
<td>4</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>OBJECTIVE FUNCTION</td>
<td>QUADRATIC</td>
<td>QUADRATIC</td>
<td>2.444444433</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>CONSTRAINT FIRST</td>
<td>2</td>
<td>3</td>
<td>5.999999966</td>
<td>&lt;=</td>
</tr>
<tr>
<td>7</td>
<td>CONSTRAINT SECOND</td>
<td>2</td>
<td>1</td>
<td>2.888888892</td>
<td>&lt;=</td>
</tr>
<tr>
<td>8</td>
<td>NON-NEGATIVITY</td>
<td>&gt;=</td>
<td>&gt;=</td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>OUTPUT RESULTS</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td></td>
<td>x1</td>
<td>x2</td>
<td>2.444444433</td>
<td></td>
</tr>
<tr>
<td>11</td>
<td></td>
<td>0.666666678</td>
<td>1.555555537</td>
<td>2.444444433</td>
<td></td>
</tr>
</tbody>
</table>
Solver Parameters

Set Objective: $S6$

To: ☐ Max ☐ Min ☐ Value Of: $

By Changing variable Cells: $B8$ to $G9$

Subject to the Constraints:
- $E9$ to $E14$
- $E15$ to $E16$
- $E17$ to $E18$
- $E19$ to $E20$
- $E21$ to $E22$
- $E23$ to $E24$

☑ Make Unconstrained Variables Non-Negative

Select a Solving Method: GRG Nonlinear

Solving Method

Select the GRG Nonlinear engine for Solver Problems that are smooth nonlinear. Select the LP Simplex engine for linear Solver Problems, and select the Evolutionary engine for Solver problems that are non-smooth.

Microsoft Excel 14.0 Answer Report
Worksheet: Quadratic Optimization Problem
Result: Solver found a solution. All Constraints and optimality conditions are satisfied.

Solve Engine
Engine: GRG Nonlinear
Solution Time: 0.031 Seconds.
Iterations: 0 Subproblems: 0

Solver Options
Max Time 100 sec, Iterations 100, Precision 0.000001, Use Automatic Scaling, Show Iteration Results
Convergence 0.001, Population Size 100, Random Seed 0, Derivatives Central
Max Subproblems Unlimited, Max Integer Sci's Unlimited, Integer Tolerance 5%, Assume NonNegative

Objective Cell (Max)

<table>
<thead>
<tr>
<th>Cell</th>
<th>Name</th>
<th>Original Value</th>
<th>Final Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>$S5$</td>
<td>QUADRATIC TOTAL</td>
<td>2.444444433</td>
<td>2.44444433</td>
</tr>
</tbody>
</table>

Variable Cells

<table>
<thead>
<tr>
<th>Cell</th>
<th>Name</th>
<th>Original Value</th>
<th>Final Value</th>
<th>Integer</th>
</tr>
</thead>
<tbody>
<tr>
<td>$B8$</td>
<td>$x_1$</td>
<td>0.666666673</td>
<td>0.666666578</td>
<td>Contin</td>
</tr>
<tr>
<td>$C8$</td>
<td>$x_2$</td>
<td>1.555555537</td>
<td>1.555555537</td>
<td>Contin</td>
</tr>
</tbody>
</table>

Constraints

<table>
<thead>
<tr>
<th>Cell</th>
<th>Name</th>
<th>Cell Value</th>
<th>Formula</th>
<th>Status</th>
<th>Slack</th>
</tr>
</thead>
<tbody>
<tr>
<td>$D6$</td>
<td>CONSTRAINT FIRST TOTAL</td>
<td>5.999999965</td>
<td>$D6 = S6$</td>
<td>Binding</td>
<td>0</td>
</tr>
<tr>
<td>$D7$</td>
<td>CONSTRAINT SECOND TOTAL</td>
<td>2.888888892</td>
<td>$D7 = S7$</td>
<td>Not Binding</td>
<td>1.111111108</td>
</tr>
<tr>
<td>$B8$</td>
<td>$x_1$</td>
<td>0.666666673</td>
<td>$B8 = 0$</td>
<td>Not Binding</td>
<td>0.666666678</td>
</tr>
<tr>
<td>$C8$</td>
<td>$x_2$</td>
<td>1.555555537</td>
<td>$C8 = 0$</td>
<td>Not Binding</td>
<td>1.555555537</td>
</tr>
<tr>
<td>$D6$</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Answer Report 1
VI. CONCLUSION

Quadratic optimization is an important area of optimization that deals with optimizing an objective function subject to nonlinear constraints. Excel Solver is a powerful tool that can be used to solve such optimization problems by adjusting the decision variables within specified constraints to achieve the optimal solution. Through literature review, it is clear that Excel Solver has been successfully applied to a wide range of quadratic optimization problems in various fields, such as engineering, finance, and management. However, it is important to note that the results obtained using Excel Solver are sensitive to the problem formulation, choice of solver settings, and other factors that can affect the convergence of the optimization algorithm. To achieve optimal results using Excel Solver, it is important to carefully define the objective function, decision variables, and constraints, as well as select appropriate solver settings and verify the validity of the obtained solution. Overall, quadratic optimization and Excel Solver represent an important and evolving area of research that has the potential to yield significant benefits in a wide range of practical applications. With continued research and development, Excel Solver and other optimization tools can be expected to play an increasingly important role in addressing complex optimization problems in various fields.

REFERENCES
